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Intro to 3D Printing 
 

3D printing is a process of additive manufacture, this is where layers upon layers of material are 

built up to create a three dimensional object from a digital design. 

 

The 3D printer at MPL (and most commercially available 3D printers) use fused deposition 

modeling technology to create objects. FDM is where plastic filament or thread is unspooled 

from a coil and fed into motor that which then pushes it through a heated extrusion nozzle. 

Think of it like a glue gun, the hot plastic comes out and fuses to the layer below it. The layers 

are slowly built up until an object is formed. The way the form comes together is controlled by 

the design file. When your file is processed it is sliced up into flat, thin readable layers. With 

each new layer the build plate lowers a tiny bit creating space for the new layer to be added on. 

 

FDM stands for:  

 

Anatomy of the Printer 
 

Draw a line from the corresponding part to where it is located on the 3D printer. 

 

Touch screen 

 

Printer Jets 

 

Filament Cartridge 

 

Print Pad 

 

USB 
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Safety While Printing 
 

Match the safety symbols with what they mean and the areas of the printer which they apply 

to. 

 

 

 

 

 

  

 

 

                     
 

 
 
 
 
  
 CAUTION 
 
 
 
 
 
 
 

Material Safety Data Sheets (MSDS) detail any hazards that could be associated with the 

materials used while printing.   

 

Select all that are true. The Markham Public Library provides MSDS for the following items 

associated with the 3D Printers. 

 Hot Water 

 ABS Plastic 

 CubeStick Glue 

 Build Plate 

 Sandpaper 

 PLA Plastic 

 Print Jets 

 Electronics 
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Design Options 
 

Here is a list of the free 3D design software: 

 
 

And here is a list of sites to download files from: 
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Things to Think About when Selecting/Creating a Design 
 

Copyright & Intellectual Property 

See the Government of Canada Canadian Intellectual Property Office website for more 

information including the Canadian Copyright Act. Additionally, see the Creative Commons 

website for information on how their licensing and reuse permissions work.  

 

Design Settings Matter 

Not all the designs you download will print properly. Even when it is an object that you have 

found online and have seen other printed examples of. Details such as number of microns, 

fill percentage, supports used, raft, sidewalk or even the type of printer can contribute to 

the success or failure of a print. 

 

Consumer Product Safety 

The Consumer Product Safety Act of Canada can provide you with the regulations required 

to ensure that your product is safe. You can visit the Health Canada about Consumer 

Product Safety website for more information. 

 

Printing Food Safe Items 

Currently the Markham Public Library only offers printing in ABS plastic.  ABS plastic should 

not be used with food as it is not BPA-free. Is recommended that 3D printed items be used 

for display or prototype only. 

 

Printing Weapons 

See the Government of Canada Department of Justice website for the Canadian Criminal 

Code and the Canadian Firearms Act in respect to what is prohibited under Canadian Law. 

Additionally, we ask that you respect the Markham Public Library Customer Service promise 

found on our website and act with civic responsibility.  
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.STL 

.stl is the only file format that can be converted using the CubePro software. You cannot 

design objects using the CubePro software only convert .stl files into .cubepro files. 

 

Supports 

Supports are required for any part that has an overhang. The rule of thumb is anything with 

a 45 degree angle or greater will require a support.  If you do not add a support and one is 

needed your project will a best droop and at worst fail completely. 

 

Raft or Sidewalk 

A raft is a mesh that your object is built on top of. A sidewalk runs around the outside of 

your object and helps keep the corners sharp. Both options help anchor  small parts to the 

build plate and help to stop edge curling/shrinkage.  

 

CubePro Software  
 

The CubePro software can be found in the CAVE (Creative Audio Visual Experience) digital 

media lab at the Cornell Library or you can download it yourself at 

http://www.3dsystems.com/shop/cubepro/activate  just scroll to the bottom of the page and 

look under Software.   

 

You can also go through an online CubePro Software walkthrough here: 

http://infocenter.3dsystems.com/cubepro/user-guide/cubepro-software  

 

1. Launch the CubePro Software 

Select the CubePro icon on the desktop. 

 

2. Open Model 
Select the Open Model button on the Home tab, this will launch a pop-up window. Select your 

.stl from you downloads folder or from your USB, then select OK. Your object should appear on 

the stage which is a digital representation of the build plate. 

File Error 
If you get the message ‘3D Verify has determined that your STL file is bad, do you want to 
open and continue with the 3D Verify fixed STL file?’ 
Simply select OK.  
This will save a new ‘fixed’ copy of your STL file in the same folder as the original. The fixed file 
with have a _v and the end of it. For example if the file is called: LabradorLowPoly.stl the fixed 
file will be LabradorLowPoly_v.stl 

http://www.3dsystems.com/shop/cubepro/activate
http://infocenter.3dsystems.com/cubepro/user-guide/cubepro-software
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Size Issue 
You may also get the message ‘Open file in mm?’ Select OK. You can always change the size of 
your file later by selecting the ‘to inch’ option under Scale Geometry. 

 

3. View Your Model 
Select the View tab. View your object from different perspective by selecting the Top View, Left 

View, Right View and Front View buttons. You can also zoom in and out by selecting the Zoom 

In or Zoom Out buttons. You can also manually manipulate the digital stage by clicking the left 

mouse button and holding as you move the cursor around the screen. 

Tip  
Make sure your object is sitting flat on the build plate if not you will require supports which can 
be added after you select Build button. You can also change your object’s placement using the 
Move Geometry or Rotate Geometry tools. 

 

4. Move Geometry 
This will change the placement of your object on the stage. Select the Home tab, then in the 

Move Geometry section of the tools ribbon select Move Model. This will allow you to drop and 

drag your object to another spot on the stage. You can also use the Move X and Move Y 

buttons, change the number to negative to move your object in the opposite direction. A red 

square will appear when your object is outside of the build area. 

Tip 
Make sure you deselect the button after you have made your changes.  

 

5. Rotate Geometry 
This will change the rotation of your object on the stage. Sometimes an object will import 

incorrectly and not be sitting flat on the build plate and a simple rotation will correct this issue. 

Select your model and then select the rotate X°, Y° or Z° button. Select Revert to rotate your 

object back into the original position. Make sure to deselect your object once your rotation 

changes are complete. 

Tip 
You cannot lower an object to the build plate if it is not sitting flat. You would need to add 
supports under it. 
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6. Set Colours – Printer Configuration 
In order to set the colours to print go to the Settings tab and select the Printer Configuration 

button. A pop-up window will appear with a number of options. If you are printing in one colour 

only, please set up both jets but make sure that the colour you want to print in is in Print Jet 1. 

Printer Type Cubepro 

Nylon Options Leave this box unchecked as MPL currently 

does not offer nylon printing. 

Print Jets 2 

Print Jet 1 Material Use the drop down menu to select the print 

jet material and colour. Currently, MPL only 

offers ABS printing so it should always say ABS 

before the colour. Check with library staff to 

see what colours are currently available for 

printing. 

Print Jet 2 Material 

 

Tip 
Make a note of your settings. Library staff will set up the printer cartridges in advance, you will 
need to let them know what colour you selected for Print Jet 1 and Print Jet 2. 

 

7. Pick Colour  
Go to the Home tab, the Pick Colour circles will now reflect the printer configuration you have 

made. Select your colour, then select your item, then deselect your colour.  

Tip 
If you wish to print an object with multiple colours you must set this up during the design stage 
of your object. Colour is associated with the shell layers of your design and therefore multiple 
colour prints should have multiple shell layers. One layer means one colour only. 

 

8. Build 
Once your changes are complete select the Build button, this will launch a pop-up window.  

9. Build – Print Mode 
Set your Print Mode, from the drop down menu select Premium, Standard, Draft or Custom. 

The settings for these modes will be displayed in the sections for Print Quality, Print Strength 

and Print Pattern. 
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Layer resolution in measured in microns (um). A micron or a micrometre is the term for one 

millionth of a metre, which is one thousandth of a millimetre and is equivalent to roughly 

0.000039 inches. 1mm = 1000 microns 

10. Build – Raft and Support 
Decide whether you would like to add a raft, supports or a sidewalk to your item. Use the drop 

down menus to select None or the colour in which these structures will be printed in. 

11. Build  
Once you have all of your options set select the Build button at the bottom of the pop-up 

window. 

12. Save your File 
Save your file to a USB. The file should not be in a folder as it will not be able to be located by 

the Cubepro printer. We recommend saving your file with a recognizable file name as you may 

try to convert it several in order to change the estimated print time, etc. Save File As: Name Jet 

1 Colour Jet 2 Colour Print Mode Supports.  

Example: Dog Black White Standard Raft 

Select the Save button when done. 

13. Time 
One your file is converted you will see the estimated print time appear on the screen. Please 

make a note of this as you will need to provide the estimated time when you book the printer. 

Note 
At this point you may want to go back in and try converting your file with various settings as to 
impact the time it takes to print, etc. Just remember that if you are saving multiple prints you 
need to remember which one will be your final. 

 

14. The Build Progress pop-up window will ask you if you want to ‘Replace the model file with the 

generated build file’, we recommend that you always look at the generated build file to 

determine if your file will print correctly. Select ‘Yes’ and you will see your converted file on the 

screen. This is how your file will print. If it looks solid then your file will correctly but if this file 

looks thin and you can see areas where the build plate shows through then your file will print 

this way. To repair this type of issue you need to improve the shell layer of your .stl file.  
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Unfortunately, MPL does not provide 3D design support. Changes required to the digital design 

file in order to improve the quality of the 3D print are the responsibility of the customer.  We 

recommend taking the tutorials provided by both the free and commercial 3D design software 

to assist you in developing your 3D design skills. 

 

15. When printing one colour with only one print jet we recommend saving your file twice, once 

with it set up to print from Jet 1 and once with it set up to print from Jet 2. This will give you a 

back-up option if Jet 1 of the 3D printer is not functioning correctly.  

 
Book the Printer  
 
Visit the library branch or call to book the 3D printer. Walk-in appointments are welcome 

provided there are no prior reservations. Maximum 4 hours per print job but you can special 

request longer time slots when required. No overnight printing, all print jobs should be 

estimated to end a half hour before close of the library. Please provide your library card number 

when booking the printer so staff can confirm that you are certified to use the 3D printer. 

When booking the printer you will need to let staff know the following information: 

Colour in Print Jet 1: 
 

Colour in Print Jet 2: 
 

Estimated Print Time: 
 

 
 
Get Printing 
 
At the time of your printing appointment bring your USB with both your .stl and your .cubepro 

file on it.  Go to the information desk and let the library staff know that you are here for your 3D 

printer appointment.  They will direct you to the printer set-up for you and walk you through 

the printing process. 
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Printing Process 
 

1. Plug your USB into the printer. 
2. Touch the touch screen to start. 

3. Select the Print icon on the touch screen. 

4. Find your file by scrolling through your USB using the touch screen arrows, select the 

PRINT button on the bottom of the touch screen. 

5. Wait for the printer to lift and then lower the print plate. Open the door once the print 

plate stops moving and apply the glue in the following pattern: 

 
Apply the glue in 2 layers, firstly in small circular motions moving from front to back and 

then in small circular motions moving from left to right. You only need to apply glue in 

an area slightly larger than the area of your object. Close the printer door and select the 

checkmark at the bottom of the touch screen when you are finished. 

6. The printer will now process the file and begin printing. 

If at any time during the printing process if your print goes awry staff will cancel the 
print job and make note of the time. You will be charged only for the print time used. 

7. Please return approximately 15 minutes before your print job is estimated to be 

complete. Prints can run under or over time. 

8. Once your print is complete, the completed print time will be displayed on the touch 

screen. Take note of the completed print time as it will indicate your final print payment 

required.  

9. Get a library staff member to unlock the printer door and record the completed print 

time. 

10. Pay for your print job. 

11. Select the checkmark button on the touch screen so that the printer begins the cool 

down process. 

12. Remove the print plate after allowing for it to cool. Take it, along with the scraper to the 

sink on the 2nd floor in the fireside lounge area. 

13. Run the print plate and your object under hot water.  Run the water until the glue is 

fully dissolved and the object releases from the plate. Use the scraper to gently prod 

your object or lift the edge so the water can get to the glue beneath it. 
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Be careful when using the scraper. Always keep your hands behind the scraper, do not 
use excess force. Only use the scraper to pry underneath your object so the water can 
get to the glue. 

 

14. Once your object is released dry the print plate and return it to the printer or library 

staff.  

 

3D Certification Quiz 
 

The last step of the 3D Printing Certification process is to complete the 3D Printing Certification 

Quiz which can be found on both the MPL website and our CAVE blog.  

 

The Cave Blog can be found here: http://thecavemarkham.blogspot.ca 

 

Once you have completed the 3D Printing Certification Quiz you can print out your certificate 

and present it to a library staff member at the Cornell Library branch to have the updated 

certification information added to your account. 
 

http://thecavemarkham.blogspot.ca/

